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1 Introduction

Plato is a design environment that uses Topology Optimization (TO) to create “Generative
Designs”–designs that are optimized to meet user-specified functional requirements. It does
this by iteratively running Finite Element Analysis to simulate the required physics and
then optimally placing material to meet the desired objective. The objective could be things
like maximizing stiffness, maximizing heat flow, or minimizing stress. The user specifies
the “function” and Plato determines the “form”. Plato includes a powerful graphical user-
interface that allows the user to set up the problem and then actively monitor and guide
the evolving design.

Plato leverages existing tools where possible. It is built on the Sandia Analysis Work-
bench (SAW)–a plug-in environment for setting up and running finite element analy-
sis problems. This environment provides many of the capabilities required for running
topology optimization. Plato also leverages the CUBIT geometry and meshing toolkit.
The CUBIT functionality is included as a component in the Plato environment. See
https://cubit.sandia.gov for more information about CUBIT.
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2 Installation and Running Plato

These instructions are specific to Sandia users. If you are not a Sandia user and need
help configuring your installation of Plato please contact the Plato team at plato3D-
help@sandia.gov.

2.1 Running on the Sandia CEE LAN

Both the Sandia SRN and SCN CEE LANs have Plato installed on them. Simply type
“/projects/plato/plato” to launch Plato on these LANs. The default installation of Plato
uses Sierra/SD as its finite element engine so you will need to have permission to run the
Sierra physics codes. If you do not already have access to Sierra physics codes see the
section below on signing up for Sierra access. At this point you have all you need to run
plato jobs on your local CEE blade. To launch topology optimization runs on the HPC
platforms you will need an HPC account. If you do not already have an HPC account see
the section below on obtaining an HPC account.

2.1.1 Signing Up For Sierra Access

To sign up for access to run Sierra physics codes go into Webcars and sign up for “SIERRA
Analysts Code Access”. This will probably require manager approval and may take
overnight to get into the system.

2.1.2 Obtaining an HPC Account

To sign up for an HPC account first go into Webcars and sign up for “SRN Capacity
Clusters” or “SCN Capacity Clusters” depending on your needs. This will probably re-
quire manager approval and may take overnight to get into the system. Next, go to wc-
tool.sandia.gov/wctool and submit a request for a WCID. You will use your WCID when
launching topology optimization runs on the HPC platforms. If necessary, work with your
manager to obtain the correct input for your WCID application.

2.2 Running Your Own Local Installation of Plato at Sandia

If you are not running on a LAN where Plato is already installed you will need to download
your own version of Plato and install it on your local machine. To download Plato go to
www.sandia.gov/plato3d and click on the ”Downloads” link. Once you have downloaded
the install package follow the instructions below for your platform.

5

mailto:plato3D-help@sandia.gov
mailto:plato3D-help@sandia.gov
https://wctool.sandia.gov/wctool
https://wctool.sandia.gov/wctool
http://www.sandia.gov/plato3d


2.2.1 Windows

If you downloaded the .zip file unzip it (it is recommended that you choose an area to
unzip the file with no spaces in the path and in a location with a fairly short path name).
If you downloaded the self-extracting .exe file launch it to unzip the package. After you
unzip the package the contents of the top level PLATO directory will look something
like that shown below. To launch Plato double-click on the “PLATO.bat” file. Note
that there is a “PLATO.exe” executable down in the “data” directory but
launching this file will not work correctly.

2.2.2 Mac

After downloading the Mac install package unzip the file if necessary. After you unzip the
file the contents of the top level PLATO directory will look something like that shown
below. To launch Plato double-click on the “PLATO.command” file. Note that there is
a “PLATO.app” executable down in the “data” directory but launching this
file will not work correctly.
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2.2.3 Linux

After downloading the Linux install package unzip the file if necessary. After you unzip
the file the contents of the top level PLATO directory will look something like that shown
below. To launch Plato double-click on the “PLATO.sh” file. Note that there is a
“PLATO” executable down in the “data” directory but launching this file will
not work correctly.

2.3 Installing and Running Outside of Sandia

This section describes how to install and run Plato and Sierra outside of Sandia where
both Plato and Sierra reside on a local machine. If you plan to load Sierra on a remote
cluster please contact the Plato team at plato3D-help@sandia.gov.

2.3.1 Mac OS (binary Sierra distribution)

1. Download the sierra binary package from https://sierradist.sandia.gov. The Mac
version will be named something like “binary darwin base 4.40.1 gcc-4.7.tar.gz”.

2. Unzip and untar the package and follow the instructions in the README file to
install sierra. After following all of the instructions for the installation you should
have a SIERRA INSTALL DIR environment variable setup in one of your resource
files (.bashrc, .cshrc, .bash profile, . . . ). To test that things are setup correctly you
should be able to type “which sierra” and “which decomp” at a newly opened terminal
window and see a path to your sierra installation binary directory. If this isn’t setup
correctly plato will not be able to launch sierra.

3. Download the plato installation package from https://sierradist.sandia.gov and follow
the instructions in subsubsection 2.2.2 on page 6.

4. Unzip the plato install package on your system and launch “PLATO.command” in
the top level directory. This will start plato.

5. Select the “Window->Preferences” menu item to bring up the plato preferences.
Choose “Job Submission->Execution Templates” in the list of preferences. Click on
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“Plato Salinas local” and then on the “Edit” button in the right column.

6. At the top of the “Job commands” area you will see a couple of “source . . . ” lines in the
script (see below). Make sure that the second one refers to the resource file where you
added the definition of the SIERRA INSTALL DIR environment variable in step 2. After
doing this click “Ok” and then “Ok” again to exit out of the preferences area. At this
point plato should be able to launch sierra correctly.

2.3.2 Linux OS (binary Sierra distribution)

1. Download the sierra binary package from https://sierradist.sandia.gov. The Linux
version will be named something like “binary linux base 4.40.1 intel-14.0.tar.gz”.

2. Unzip and untar the package and follow the instructions in the README file to
install sierra. After following all of the instructions for the installation you should
have a SIERRA INSTALL DIR environment variable setup in one of your resource
files (.bashrc, .cshrc, .bash profile, . . . ). To test that things are setup correctly you
should be able to type “which sierra” and “which decomp” at a newly opened terminal
window and see a path to your sierra installation binary directory. If this isn’t setup
correctly plato will not be able to launch sierra.

3. Download the plato installation package from https://sierradist.sandia.gov and follow
the instructions in subsubsection 2.2.3 on page 7.

4. Unzip the plato install package on your system and launch “PLATO.sh” in the top
level directory. This will start plato.

5. Select the “Window->Preferences” menu item to bring up the plato preferences.
Choose “Job Submission->Execution Templates” in the list of preferences. Click on
“Plato Salinas local” and then on the “Edit” button in the right column.
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6. At the top of the “Job commands” area you will see a couple of “source . . . ” lines in the
script (see below). Make sure that the second one refers to the resource file where you
added the definition of the SIERRA INSTALL DIR environment variable in step 2. After
doing this click “Ok” and then “Ok” again to exit out of the preferences area. At this
point plato should be able to launch sierra correctly.
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3 Simple Tutorial

This section will walk you through a simple design problem using topology optimization
to design a bracket to mount a lantern to a wall. To run this example you will need to
download the model file “lantern bracket.cub”.

The design domain will be a simple blocky shape shown in the figure on the right above.
A load representing the weight of the lantern will be applied as shown by the red arrow
and the back of the domain will be fixed at the location indicated by the parallel red lines
representing where the bracket would be attached to a wall. We will require that the final
design only use 10% of the starting design domain volume.

3.1 Create a new Model

1. Create a new model by choosing “File->New->Model” from the menus.
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2. Choose “New Model” for the category and click “Next”.

3. Choose “Create From Template” and click “Next”.
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4. Type “lantern bracket” in for the “Model name”, choose the “Sierra SD Templates-
>Structural Dynamics->Topology Optimization” template, and click “Finish”.

3.2 Import the Design Domain or Envelope

1. Right-click on the “Geometry/Mesh” icon in the tree and choose “Import...”.
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2. Choose “CUBIT” as the file type and click “Next”.

3. Browse to find the file “lantern bracket.cub” and click “Finish”.
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4. Click on the “Save” icon in the toolbar to save the model.

3.3 Set Up Blocks

There are two element blocks already defined in the design envelope model we imported.
The image below shows the two blocks colored green and yellow for identification purposes.
You can see a similar coloring by typing “draw block all” in the CUBIT command console
window. We need to assign materials to these blocks and specify that one of them will be
optimized and the other will be fixed.
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1. Expand the “Sierra Structural Dynamics” node in the tree by clicking on the triangle
to the left of it. Then expand the “Finite Element Model” node and click on “FEM Mesh”.
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2. In the “Settings” view you will see the information about the mesh as shown below.

3. Click on the white space under “Material” next to Block 1 to reveal a dropdown menu
and select “1” from the menu. This assigns material 1 to this block (material 1 was
previously defined in the template we used for creating this model and its properties can
be seen in the “Materials” section of the tree). Similarly, click on the white space under
“Element” in the Block 1 row to reveal a dropdown menu and select “hex8u” to assign
the element type for this block. Do the same thing for Block 2 until your settings match
those below. Note that when you click on Block 1 in the table most of the design envelope
in the graphics window is highlighted. This will be the optimizable region. Clicking on
Block 2 will show the region that will not be optimzed–it will be “fixed”. We will now
enter a topology optimization parameter to specify that Block 2 is fixed.
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4. Expand the “Topology Optimization” node in the tree and click on the “Topology-
Optimization” node to show all of the topology optimization parameters in the Settings
view as shown below.

5. Right-click anywhere among the existing parameters and choose “Add->fixed block ids”.
Once the new parameter is added (probably at the end of the list) you can click on it and
add the value “2” to specify that Block 2 will be fixed.

3.4 Specify Functional Requirements

The functional requirement for this problem is that the lantern bracket must support the
lantern and be as stiff as possible given a volume budget of 10% of the original design
envelope. The requirement to support the lantern must be communicated to plato in a
way that the topology optimization can understand. This is most simply accomplished by
specifying the location on the design envelope that must remain “fixed to the wall” and
the location from which the lantern will hang or exhibit a vertical load on the bracket.
In this section we will define the fixed boundary condition and the applied load which
represent the functional requirement as well as the constraint that we can only use 10% of
the starting volume (design envelope).

17



1. At the bottom left corner of the graphics window there is a small toolbar. Select the
orange “Exodus” filter button and then the “nodesets” selection filter as shown in the
image below. If you hover the mouse over the buttons it will tell you what each one is.

2. Zoom into the two small holes in the design envelope as shown in the image below. Click on
the inside surface of one of the holes to highlight the nodeset that is defined on the inside
of the two holes. You should see the nodes highlight in orange like in the image below.
Now right-click on the nodeset and choose “Apply Boundary Conditions->boundary”.
This will create a boundary condition in the tree under the “Boundary Conditions” area
for the nodeset that was selected.
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3. Click on the new Boundary Condition in the tree as shown below. This will show the
nodeset in the Settings view that was used to create the boundary condition. Clicking on
the nodeset in the Settings view will show below all of the possible boundary conditions
that can be defined. Scroll down and select “fixed”. This will make this a fixed boundary
condition–the location where the bracket will be mounted to the wall.

4. Zoom into the one hole at the other end of the design envelope as shown below. Select the
“Sideset” selection filter from the tool bar as shown and click on the inner surface of the
hole to highlight the sideset that is defined there.
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5. Right-click on the sideset and choose “Apply Loads->Loads”. Note that there is also an
“Apply Loads->Load” item but in this case we will use the “Loads” option. This will
create a load item in the tree under “Loads” and clicking on the load as shown below will
show its options in the Settings view.

6. Click on the sideset in the Settings view to show all of the load options below. Scroll down
and select “traction” and enter “0 -1e5 0” to represent a load in the negative y direction.
After you hit Enter you should see the traction definition next to the sideset as shown
below. For simple compliance minimization (maximize stiffness) the magnitudes of loads
are not too critical in determining the optimally stiff design given the volume budget but
it is important for the stability of the optimization algorithm to be roughly consistent
with magnitudes and units.
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7. Finally, we need to set the target volume fraction to be 0.1 of the original design
envelope. Click on the “Topology-Optimization” node in the tree under “Topology Opti-
mization” to show all of the topology optimization parameters in the Settings view (see
below). Click on the “volume fraction” parameter and change its value to 0.1 and hit enter.

3.5 Submit the Job

At this point the problem is fully defined and ready to be submitted to the optimizer.
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1. Clicking on the “Sierra Structural Dynamics” node in the tree will bring up the job
submission settings in the Settings view as shown in the image below. Under the
“Job Submission” section set the “Code” to “Salinas”. If you will be submitting the
optimization job to a remote computer or cluster set the “Machine” to the name of that
machine. If you have installed Sierra on your local machine and will be running there
choose “local” for “Machine”. If you are running on a remote machine set the “Execution
Template” to “Plato Salinas XXX” where ”XXX” is the name of the remote machine.
If you are running locally set the “Execution Template” to “Plato Salinas local”. If you
don’t see one of these templates make sure that the “Show All” box to the right is checked
so that all of the available templates are visible. Under the “Resources” section (not
expanded in the image below) make sure that “lantern bracket.exo” is selected. This will
ensure that this mesh file is sent to the remote system for the run. Under the “Machine”
section make sure that “Clear job run directory” is selected.
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2. If you are running locally you can ignore the following instructions about “Queue”,
“Time”, and “Account” but will need to set the number of processors and submit the
job as instructed at the end of this step. Under “Queue” choose the type of queue for
your HPC account. Under “Time” select 30 minutes. Under “Account” enter your HPC
account (WCID). The first time you submit a job you should click on the “Preferences”
button to the right of “Account” and enter your HPC account info. After that you can
just select your account from the list. Under “Processors” choose 8. Then scroll back up
to the top of the Settings view and click on the link labeled “Submit Simulation Job”.
This will submit your job locally or to the HPC machine.

3.6 Monitor the Job

Once you have submitted the job there are a few views where you can monitor what is
happening.
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1. The first thing to check is that in the console view you see the message “Job Submission
completed normally”. Prior to this message there will be various output scrolling by in the
console view having to do with files being pushed to the remote system and other tasks
associated with the job submission. Once these are finished you should see the message
below about the successful submission.

2. After the job has been successfully submitted you can check the Job Status view to see if
the job has made it through the queue or is still waiting in the queue. If the job is still
waiting in the queue the “Queue Status” will show “Idle”. However, once it starts running
the “Queue Status” will show “Running”.
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3. Once the job starts running you will see results displayed in the graphics window as the
design evolves. These results are stored in the “Geometry/Mesh” node of the tree and you
can display the various results by clicking on them in the tree. An example is shown below.

3.7 Restart

Now, suppose we estimated the wrong volume budget for our lantern bracket. One of
the nice things in Plato is the ability to restart the optimization from one of the existing
design iterations. This allows the user to run for a while, stop, change parameters, and
then restart where the optimization left off. In this example, we will change the volume
budget to a new value and then restart the optimization to see how it affects the results.
The following steps will illustrate how to do this.
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1. The first step is to decide what iteration you want to restart from. You can look at the
various iterations in the “Geometry/Mesh” part of the tree and choose one. Typically,
you would choose an iteration at a point where the design seems to be converging. In
most cases you would probably just choose the last iteration. Once you have chosen the
iteration to restart from click on the “Topology-Optimization” node in the tree under
“Topology Optimization” to show all of the current topology optimization parameters.
Right-click anywhere among the topology optimization parameters in the Settings view
and choose “Add->restart index”. This will add a new parameter to the list called
“restart index”. Enter the iteration number you want to start from as the value for the
“restart index” parameter. For example, if I wanted to start from “Iteration025” I would
enter “25” as the “restart index”. An example of this is shown below.
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2. Next, change the volume budget to the new value. Click on the “Topology-Optimization”
node in the tree under “Topology Optimization” to show all of the topology optimization
parameters in the Settings view. Click on the “volume fraction” parameter and change its
value to 0.2 to give it twice as much volume to work with and hit enter (see below).
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3. Next, click on the “Sierra Structural Dynamics” node in the tree to bring up the job
submission panel. Under the “Machine” section make sure that “Clear job run directory”
is NOT selected. Because we want to use the results from the previous run we need
to make sure not to clear the directory before starting. At this point just click on the
link labeled “Submit Simulation Job” and a new job will be submitted starting from the
specified iteration and with the new volume budget. A result with 20% volume budget is
shown below. You can change almost any parameter you want when doing a restart. The
two things you cannot do are change the mesh or change the number of processors.

WARNING: When you do a restart your results from the previous run
will be overwritten. To avoid this you can make a copy of your current model by
right-clicking on the model node in the tree (the top level node) and choosing “Duplicate
Model”. You will be prompted for a new name and a copy of your model will be created.
You can then restart from the copy and not affect the original model and its results.
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4 Example Problems

Plato has some example problems completely setup that you can load and run. This section
will describe the process for loading these examples.

1. Create a new model by choosing “File->New->Model” from the menus.

2. Choose “Tutorial Examples” for the category and click “Next”.
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3. Choose one of the tutorial example models and click “Next”.
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Accept the default model name and location and click “Finish”.

At this point Plato will create a new model containing the example problem and
you can modify the default parameters or choose your own and run the optimization
as usual. Example results for the Crank, Hanger, and RoundTable tutorial examples
respectively are shown below for reference.

Crank, Hanger, and RoundTable tutorial example results.
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5 The Overall Process

Designing with topology optimization is fundamentally different from traditional CAD
design. In traditional design an engineer or designer will typically mock up a design in
a CAD system using his or her knowledge and experience related to the design space.
The result is a CAD model specifying the “form” of the design with the hope that it
will meet the “function” required of the design. The function is then often assessed using
experimentation or computational analysis. When designing with topology optimization
this traditional design paradigm is inverted. Instead of defining the form of the design
the engineer or designer specifies the required function and lets the topology optimization
come up with the form that will meet that function based on computational analysis. This
section describes the main steps in designing with topology optimization using Plato.

5.1 Problem Setup

Problem setup consists of defining the design envelope or allowable space in which the
optimized design can reside and the functional requirements that need to be met by the
design.

5.1.1 Problem Domain Definition

The design domain or envelope is the allowable space that the optimized design can occupy.
This could be as simple as a cubic bounding box or much more complicated if the component
being designed is part of a complex assembly of components. Based on your requirements
you will need to define what this allowable space looks like and generate a solid model to
represent it. This can be done within Plato using the solid modeling capabilities there or
in another CAD package if it is easier. If you will be generating this solid model external
to Plato you should save it in the STEP format so that it can be imported into Plato.
If you will be generating the solid model for the design domain using the solid modeling
capabilities in Plato please see the CUBIT user manual [1] for complete documentation on
these capabilities.

5.1.2 Mesh Generation

The input for the topology optimization consists of a finite element mesh of the design
domain defined in 5.1.1 and an input deck with parameters defining the functional require-
ments of the design and other parameters to guide the optimization. Therefore, the next
step is to generate a finite element mesh of the design domain solid model. A mesh can
either be created outside of Plato and then imported into Plato or it can be generated in
Plato using the CUBIT mesh generation capabilities. For detailed documentation on using
the CUBIT mesh generation capabilities incorporated in Plato please see the CUBIT user
manual [1] and CUBIT tutorials [2].
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5.1.3 Boundary Conditions and Loading

Design functional requirements are communicated to Plato via boundary conditions and
loads. For example, for the lantern bracket design problem in ?? we needed to communicate
to Plato that the bracket had to be bolted to a wall and support the load of a hanging
lantern. To do this we specified a fixed boundary condition where the design would be
attached to the wall and applied a vertical load where the lantern would hang. The
boundary condition and load capabilities exposed in Plato come from the underlying finite
element analysis package that is being used. Plato is currently using Sierra/SD as its finite
element analysis solver. For complete documentation on the available boundary conditions
and loads see sections 2.14 and 2.15 in the Sierra/SD User’s Manual [3].

5.1.4 Units and Magnitudes

It us up to the user to maintain consistent units when setting up a problem. For example,
material properties and loads should have consistent units. For compliance minimization
(stiffness maximization) the position and direction of a load are critical for determining the
“stiffest” configuration of material–not the magnitude of the load. However, if there are
multiple loads the relative magnitudes of the loads are important. Even though absolute
magnitudes don’t play a role in determining optimally “stiff” structures it is important
to get rough magnitudes of loads correct with regards to units so that the problem is
well-posed. This will help the stability of the optimization algorithm.

5.1.5 Output

By default, the input deck will populate the “OUTPUTS” block with the variables, Op-
timalTopology, VonMises and Disp. The OptimalTopology field is a nodal field which
contains the values of the design variables in the range of [0, 1] with 0 signifying void
material and 1 for solid material. Upon completion, isosurfaces are extracted using the
OptimalTopology field at a value of 0.5 at the number of iterations requested by the user.
The OptimalTopology field must be present for extraction of the isosurfaces. VonMises is
an element field containing the values of the Von Mises stress for each element. The Disp
field outputs displacements and rotations in the x, y and z directions. Since Plato is built
on Sierra/SD, other fields of interest may be output as specified in the Sierra/SD User’s
Manual [3] in section 2.9.

5.2 Topology Optimization Parameter Setup

Plato allows the user some control over the topology optimization algorithm by exposing
some of the optimization parameters. For example, the user specifies what fraction of
the original domain envelope can be used for the final design. The user can also modify
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parameters that affect the feature size and smoothness of the final design. The various
topology optimization parameters are described in detail in section 7.

5.3 Job Submission

Once all of the input for the topology optimization problem is defined the job is submitted.
The job can be submitted either to run on the local machine or on a remote cluster or
HPC platform. Plato provides a very nice interface for specifying where and how the job
will be run. The user can specify the machine, number of processors, requested time, etc.
and then launch the job with a single click. Valuable information such as current machine
load is shown graphically in the “Machines” view and helps in determining the best place
to run the job. Multiple jobs can be launched and running simultaneously in the Plato
environment.

5.4 Job Monitoring

Plato provides some nice tools for monitoring the topology optimization process as it
progresses. For jobs being run on queued systems the “Job Status” view lets the user
know when the job gets through the queue and actually starts running. This view can also
be used to kill running jobs. Once a job starts running the user will see snapshots of the
evolving design in the graphics window. The user can change how often these results are
shown depending on how large the problem is and how long each iteration takes. Each of
these snapshots represent an actual design iteration that can be viewed and manipulated
within Plato and then exported for 3D printing if desired. At any time the user can also plot
quantities of interest such as the current design volume or current optimization objective
value vs. iteration to see how quickly the process is converging to a solution.

5.5 Export for Manufacture

At any point during or after the optimization run the user can export any of the design
iterations that were generated to an STL file for 3D printing.
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6 Graphical User Interface

This section will describe the different aspects of Plato’s graphical user interface.

6.1 Main Layout

Plato leverages a full-featured graphical user interface (GUI) to provide a powerful, user-
friendly environment for doing topology optimization-based design. The image above de-
picts a typical Plato layout with many of the GUI features present. In the sections that
follow the various features of the Plato GUI will be discussed in more detail.

6.2 Menus

As with most modern GUIs Plato has a set of top level menus for accessing many of the
administrative tasks related to managing projects, models, preferences, etc.

6.3 Views

Most of the features in the Plato GUI are in the form of a separate window or view. Each
of the views can be dragged outside of the main Plato application or ”undocked” as a
separate window. To re-dock a window back into the Plato application simply click on the
tab just under the window title bar and drag that tab back into Plato. To open views that
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have been closed or did not show up in the default layout when Plato started you can go to
“Window->Show View” in the main menus and choose the view you want to show. In the
sections that follow, most of the commonly used views will be shown undocked and each
will be described in more detail. Other views are accessible by going to “Window->Show
View”.

6.3.1 Graphics Window View

The graphics window is where you do all of the graphical visualization. This is where you
see the domain envelope, any meshes you generate, design results coming back from the
optimization, etc. Like most CAD systems you can pan, zoom, and rotate the view in the
graphics window by dragging the mouse while holding down different mouse buttons. The
graphics window is the same one used in the CUBIT mesh generation software package and
has many powerful capabilities for interacting with the various models you will generate.
For more details about these capabilities see the CUBIT user manual [1].
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6.3.2 Model Navigator View

The model navigator view is where all of your models are displayed. Each model is rep-
resented as a tree and you can explore the different parts of the model by expanding its
various branches. Each model has a “Geometry/Mesh” node that contains the domain
envelope solid model, domain envelope mesh, and optimized design results. Each model
also has a node containing all of the finite element analysis data and topology optimization
data. For Sierra/SD models this node is called “Sierra Structural Dynamics”. After a
topology optimization job has been submitted a “Simulation Job” node in the tree will ap-
pear which contains the contents of the local and remote directories where the optimization
was run.
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6.3.3 Console View

The console view has multiple functions. One function of the console view is to show
text output from running processes. For example, when a job is submitted the console
window displays text output about what is happening at each stage of the job submission.
Monitoring this output is a good way to make sure things are progressing as expected or
to identify errors or problems during the process. Another purpose of the console view
is to provide a place to enter commands when using the CUBIT geometry and meshing
component in Plato. These different functions or modes of the console view are managed
by actually having multiple consoles. There is one console for displaying output and a
different console for entering CUBIT commands. You can toggle through the different
consoles at any time by clicking on the icon that looks like a computer monitor in the
toolbar in the top right portion of the console view.
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6.3.4 Settings View

The settings view is a general purpose view where many different kinds of data are dis-
played and edited depending on what is selected elsewhere in the Plato GUI. One of the
most common uses of the settings view is to view and edit the data associated with what-
ever is selected in the model navigator view. For example, in the image above topology
optimization parameters are being displayed. This is a result of the user selecting the
“Topology-Optimization” node in a model in the model navigator view. Often times pa-
rameters and data in the settings view can be edited by simply clicking on it and entering
new values. You will get used to looking to the setting view for various kinds of informa-
tion. If the settings view ever seems to “disappear” make sure that it isn’t just behind
another tab in the window where it is docked.
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6.3.5 CUBIT Command Panel View

The CUBIT command panel view is where you can find all of the GUI panels related to
performing geometry and meshing commands using the CUBIT component in Plato. For
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help on learning more about the CUBIT command panel see the CUBIT tutorial [2] on
the CUBIT GUI.

6.3.6 Input Deck Editor View

Plato contains a very nice input deck editor. The input deck is the file that controls the
simulation. This input deck editor view is where the user can view and edit the input
deck parameters defined in the model navigator tree. This editor is syntax aware so that
it can flag errors in the input deck and provide context sensitive suggestions. The input
deck editor is completely coupled with the model navigator and settings views so that any
edits made to parameters in the input deck editor are immediately reflected in the model
navigator and settings and graphics views and vice versa.
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6.3.7 Machines View

The machines view displays information about the available HPC machines that you can
submit jobs to. It displays the current load on the machine and provides functionality for
estimating how long it will take your job to get through the queue on a given machine.
This information is very valuable in determining where to run jobs.

6.3.8 Job Status View

The job status view displays information about all of the jobs that have previously run or
are currently running. This view provides one way for you to monitor the status or your
currently running jobs.
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7 Topology Optimization Parameter Reference

The input deck for a topology optimization run is a combination of parameters needed for
the finite element analysis calculations and parameters needed for the topology optimiza-
tion algorithms. This section is a reference guide for the topology optimization parameters
that are found in the input deck. They will be grouped by the physics code being used.
For a description of the physics codes see Section 8 on page 46.

7.1 Sierra/SD

The topology optimization parameters for Sierra/SD are in the “Topology-Optimization”
block in the input deck. We will only describe the basic topology optimization parame-
ters that a user would typically modify in this manual. If you have questions about other
topology optimization parameters in the “Topology-Optimization” block please contact the
Plato development team at plato3D-help@sandia.gov.

volume fraction: Specifies the fraction of the starting design domain volume that
the user wants in the optimized design. Fixed blocks are included in the calculation
of the optimized design volume at each iteration.

output frequency: Specifies how often design results will be output and displayed
in Plato during the optimization. A value of 5 means that every 5 iterations of the
optimization a result will be outputted and displayed. A value of 0 means that out-
put and display of the results will be turned off.

max num optimization itr: Specifies the number of iterations Plato will run be-
fore stopping the optimization.

filter type: Specifies the type of filter that Plato will use to smooth the design
results. Possible values are “kernel” or “laplacian”. The kernel filter is the default
filter and should work for most problems.

filter scale: Specifies the scale factor used in applying the smoothing filter. The
scale means different things depending on whether the “filter type” is kernel or lapla-
cian. If using a kernel filter the filter scale specifies the radius of influence the filter
will have. In this case the filter scale is a value that will be multiplied by the average
edge length in the mesh to get a filter radius. The default value is 3.5. If using the
laplacian filter the filter scale is a value between 0 and 1 that indicates how aggres-
sively the filter should be applied. In general, the larger the filter scale the larger the
feature size in the design results.
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filter absolute: This parameter only has meaning if the filter type is kernel. This
parameter specifies an absolute value for the filter radius used in kernel smoothing.
This parameter would be used in place of filter scale. If both filter scale and fil-
ter absolute are specified filter absolute will be used by Plato.

filter symPlane: This parameter only has meaning if the filter type is kernel. It is
used to specify the reflection plane for symmetric problems to force better smoothing
at the interface (no seams or creases). The symmetry plane must align with one of
the coordinate axes, and an offset value can also be specified.

filter iterations: Specifies the number of times the filter will be applied at each
optimization iteration to smooth the results. 1 or 2 iterations will typically provide
adequate results.

fixed block ids: Specifies the ids of the blocks in the mesh that should not be
optimized. Ids should be separated by spaces.

restart index: Specifies the index of the iteration that should be used as the initial
guess when the optimization run is restarted. When running with an initial guess
Plato will use the existing results in the remote working directory so it is imperative
that you specify that Plato not clear the remote directory prior to submitting the
job. You can indicate this in the Job Submission View.

7.2 Albany

The topology optimization parameters for Albany are found in the “basic” and “advanced”
blocks of the input deck. We will only describe the topology optimization parameters that
a user would typically modify in this manual. If you have questions about other topology
optimization parameters please contact the Plato development team.

target volume fraction: Specifies the fraction of the starting design domain vol-
ume that the user wants in the optimized design. Fixed blocks are included in the
calculation of the optimized design volume at each iteration.

update frequency: Specifies how often design results will be output and displayed
in Plato during the optimization. A value of 5 means that every 5 iterations of the
optimization a result will be output and displayed. A value of 0 means that output
and display of the results will be turned off.
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max iterations: Specifies the number of iterations Plato will run before stopping
the optimization.

filter radius: Specifies the radius of influence of the filter used for smoothing the
optimized design. This value should be at least 1.5 times the average edge length
in the mesh. In general, the larger the filter radius the larger the feature size in the
design results.

restart time step: Specifies the index of the iteration or time step that should
be used as the initial guess when the next optimization run is started. When run-
ning with an initial guess Plato will use the existing results in the remote working
directory so it is imperative that you specify that Plato not clear the remote direc-
tory prior to submitting the job. You can indicate this in the Job Submission View.

fixed block id: Specifies the id of a block in the mesh that should not be opti-
mized. Add a separate “fixed block id” command for each block in the mesh that
should be fixed.

filtered block id: Specifies the id of a block in the mesh that should have the
filter applied to it for smoothing. Typically, you should enter a “filtered block id”
command for each block in the mesh that is not “fixed” (see “fixed block id”).
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8 Physics

When a topology optimization run is launched in Plato a finite element analysis program
is being run in the background. Plato provides the interface to potentially utilize any
finite element analysis code given the right level of integration. The following subsections
describe the finite element codes that Plato currently supports.

8.1 Sierra/SD

Sierra/SD is a production-grade structural dynamics finite element analysis code developed
at Sandia National Labs. Plato currently utilizes the linear statics capabilities in Sierra/SD
for doing compliance minimization topology optimization. See the Sierra/SD User’s Manual
for more info.

8.2 Albany

Albany is an open source code that provides various physics simulation capabilities. It
has proven to be a powerful research platform for exploring new topology optimization
capabilities during the development of the Plato product. Plato provides an interface for
doing topology optimization with Albany and the user is free to install Albany and use it
in conjunction with Plato but the Albany capabilities are not considered production-grade
and are not supported at that level. For more information about Albany see the Albany
website.

46

http://www.sandia.gov/plato3d/Documents/SierraSDUsers.pdf
https://github.com/gahansen/Albany
https://github.com/gahansen/Albany


9 Theory

The basic theory behind some of the topology optimization framework is briefly discussed
next. For more in-depth coverage, we encourage the interested reader to refer to the
Theory Manual, available upon request from the Plato development team at plato3D-
help@sandia.gov.

9.1 Material Model

During the optimization process, the OptimalTopology will assume values in the range
[0, 1] where 0 signifies a void and 1 represents solid material. However, in order for the
design to converge to mostly solid or void material, it is common practice to penalize the
elements in the intermediate range (gray zones). Along those lines, the following material
models can be used to perform the optimization.

9.1.1 SIMP: Solid Isotropic Material with Penalization

The Solid Isotropic Material with Penalization (SIMP) model uses a power-law relation to
penalize the stiffness of elements compared to the amount of material used when Optimal-
Topology is neither 0 nor 1. This material is populated in the input deck by default with
material penalty model = simp. To select the power to which penalize the OptimalTopol-
ogy, the penalty coefficient can be changed, which is set to a value of 3 by default. Another
value, or a range of values, can be input to solve the problem with increasing penalization,
for example penalty coefficient = 1 1.5 2 2.5 3.

9.1.2 RAMP: Rational Approximation of Material Properties

Alternatively, the Rational Approximation of Material Properties (RAMP) model can be
used by setting material penalty model = ramp. One of the main differences between
the SIMP model and the RAMP model is that for the RAMP model, the derivatives are
continuous for void material, which can be helpful for the optimization engine. For this
model, the penalty coefficient is set in the same manner as the SIMP model, however, we
note that a value of 3 for SIMP should be compared to a value of 4 for RAMP.
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10 Data Representations

During the topology optimization process various models are generated and various data
representations are used. This section will describe the various models and data represen-
tations that you will see as you progress through the design process in Plato. A graphical
depiction of the process and models is show in Figure 1.

10.1 Design Domain Solid Model

Ultimately, the design domain needs to be represented as a finite element mesh for the
topology optimization run. If such a mesh already exists it can be imported into Plato
directly. Otherwise, a solid model of the design domain can be imported into Plato and
then meshed using the geometry and meshing capabilities in Plato. Solid models can also
be created directly in Plato if desired and then meshed. The best format for solid models
being inported into Plato is the .sat ACIS format or STEP.

10.2 Design Domain Mesh

A finite element mesh of the design domain is required as input to the topology optimization
run. The design domain mesh can be generated in Plato from the design domain solid model
or in another package and then imported into Plato. The best format if importing the mesh
is the Exodus format. It will typically have a .exo, .e, .gen, or .g file extension.

10.3 Optimized Design Results

As the optimization process advances snapshots of the evolving design will be loaded and
displayed in Plato. These design iterations are in the Exodus mesh file format and are
simply a set of water-tight mesh triangles representing the boundary of the optimized
design. Note that this is only a triangle mesh and does not contain volume mesh elements
on the interior.

10.4 Design Exported to STL Format

Any one of the design results loaded into Plato during the optimization process can be
exported to an STL file for 3D printing by simply right-clicking on the design in the Model
Tree and choosing “Generate STL”.
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Figure 1: Models encountered during the topology optimization process in Plato.
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